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Chapter 437

Tests for the Ratio of
Two Poisson Rates
Introduction
The Poisson probability law gives the probability distribution of the number of events occurring in a specified
interval of time or space. The Poisson distribution is often used to fit count data, such as the number of defects on an
item, the number of accidents at an intersection during a year, the number of calls to a call center during an hour, or
the number of meteors seen in the evening sky during an hour.
The Poisson distribution is characterized by a single parameter which is the mean number of occurrences during the
specified interval.
The procedure documented in this chapter calculates the power or sample size for testing whether the ratio of two
Poisson means is different from a specified value (usually one). The test procedure is described in Gu et al. (2008).

Test Procedure
Assume that all subjects in each group are observed for a fixed time period and the number of events, X, (outcomes
or defects) is recorded. The following table presents the various terms that are used.
Group

1

2

Fixed time interval

t1

t2

Sample Size

N1

N2

Number of events

X1

X2

Individual event rates

λ1

λ2

Distribution of X

Poisson (λ1t1 )

Poisson (λ2t2 )

Define the ratio of event rates, RR, as

RR =

λ2
λ1

Gu (2008) considered several test statistics that can be used to test hypotheses about the ratio. For example,

H0 :

λ
λ2
= RR0 versus H a : 2 > RR0 .
λ1
λ1

or equivalently,

H 0 : RR = RR0 versus H a : RR > RR0 .
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where RR0 is the ratio of event rates under the null hypothesis.
Two test statistics are available in this case. The first is based on unconstrained maximum likelihood estimates

 RR0 

X 2 − X1
 d 


W1 =
2
 RR0 
X 2 + X1

 d 
with

d = t1 N1 / t2 N 2 .
The second test is based on constrained maximum likelihood estimates

W2 =

 RR 
X 2 − X1 0 
 d 
( X 2 + X 1 ) RR0 
 d 

An equivalent pair of test statistics are available if logarithms are used. The statistical hypothesis is

λ 
λ 
H 0 : ln 2  − ln (RR0 ) = 0 versus H a : ln 2  − ln (RR0 ) > 0
 λ1 
 λ1 
or equivalently,

H 0 : ln (RR ) − ln (RR0 ) = 0 versus H a : ln (RR ) − ln (RR0 ) > 0
Two test statistics are available in this case as well. The first is based on unconstrained maximum likelihood
estimates

X 
 RR 
ln 2  − ln 0 
X
 d 
W3 =  1 
1
1
+
X 2 X1
The second test is based on constrained maximum likelihood estimates

X 
 RR 
ln 2  − ln 0 
X
 d 
W4 =  1 

RR0 
d
 2 +

+
RR0
d 

X1 + X 2
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After extensive simulation, they recommend the following extension of the variance-stabilized test proposed by
Huffman (1984) for the case when RR0 / d > 1 .



RR0
( X 1 + 3 8) 
2 X 2 + 3 8 −
d

W5 = 
RR0
1+
d
Gu et al. (2008) show that all of these test statistics are approximately distributed as a standard normal and thus
use the normal distribution as the basis of significance testing and power analysis.

Assumptions
The assumptions of the two-sample Poisson test are:
1. The data in each group are counts (discrete) that follow the Poisson distribution.
2. Each sample is a simple random sample from its population. Unlike most designs, in this design the
sample size involves a fixed time parameter. That is, instead of specifying the number of people in a
study, the number of man-hours is what is important. Hence, a sample size of 10 hours could be achieved
by ten people being observed for one hour or two people being observed for five hours.

Technical Details
Computing Power
If we define RRa as the ratio of event rates under the alternative hypothesis at which the power is calculated, the
power analysis for testing the hypothesis

H 0 : RR = RR0 versus H a : RR > RR0 .
using the test statistics defined above is completed as follows.
1. Find the critical value. Choose the critical value z1−α using the standard normal distribution so that the
probability of rejecting H 0 when it is true is α .
2. Compute the power. Compute the power for each test as follows.
For W1 , W3 , and W4 , the power is given by

 z σ − µi 

Power (Wi ) = 1 − Φ  1−α i
σi


where

Φ (z ) =

z

∫ Normal (0,1)

−∞

 RRa RR0 
−
t1 N 1λ1 ,
d 
 d

µ1 = 

 dRRa + RR02 
t1 N 1λ1
2
d



σ 12 = 
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 RRa 
 ,
RR
 0

σ 32 =

 RRa 
 ,
 RR0 


RR0 
d
 2 +
+

RR
d
0

σ 42 = 
RRa 

t1 N 1λ1 1 +

d 


µ3 = ln

µ 4 = ln

d + RRa
t1 N 1λ1 RRa

For W2 the power is computed using

 Ez − F 
Power (W2 ) = 1 − Φ  1−α

G


where
2

 RR 
RR02
,
E =  0  +
RR
RR
d
a
a


G=

RR0
RRa


RR0  λ1t1 N 1 RR0

,
F = 1 −
RR
d
a




RR02 

1 +
dRRa 


For W5 the power is computed using

 A B − z1−α C 

Power (W5 ) = 1 − Φ 


D


where


A = 21 −

C=

RR0
RRa


,



B = λ1t1 N 1 + 3 8 ,

RR0 + d
,
RRa

D=

RRa + d
RRa

Computing Sample Size
The sample size is found using the formula

 z1−α C + z Power D 

 −3 8
A


.
N1 =
λ1t1
2
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters.
Select Power when you want to calculate the power of an experiment.
Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level.
Select t1 and t2 (Exposure Time with t1 = t2) to calculate the required exposure time for a set number of subjects
to achieve a desired power. The solution is found for the case where t1 = t2.
Select RRa (Ratio of Event Rates) to find the detectable ratio for a given power and sample size.

Test
Alternative Hypothesis
Specify whether the alternative hypothesis of the test is one-sided or two-sided. If a one-sided test is chosen, the
hypothesis test direction is chosen based on whether the assumed event rate ratio (RRa) is greater than or less than
the null hypothesized event ratio (RR0).
The options are
•

One-Sided
The upper and lower null and alternative hypotheses are
Upper:

•

Lower:

H 0 : RR ≤ RR0 versus H a : RR > RR0
H 0 : RR ≥ RR0 versus H a : RR < RR0

Two-Sided
The null and alternative hypotheses are

H 0 : RR = RR0 versus H a : RR ≠ RR0
Test Statistic
This option allows you to select which test statistic will be used. Possible choices are
•

W1 = MLE
This is the unconstrained maximum likelihood test in which λ1 and λ2 are estimated separately.

•

W2 = CMLE
This is the constrained maximum likelihood test in which λ1 and λ2 are estimated jointly.
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•

W3 = Ln(MLE)
This is the logarithmic version of the unconstrained maximum likelihood test in which λ1 and λ2 are
estimated separately.

•

W4 = Ln(CMLE)
This is the logarithmic version of the constrained maximum likelihood test λ1 and λ2 are estimated jointly.

•

W5 = Variance Stabilized
This is the variance stabilized version of the unconstrained maximum likelihood test. This is the default value.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis
is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (beta = 0.20) was used for power. Now, 0.90
(beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. For one-sided tests such as this, the value of 0.025 is recommended for
alpha. You may enter a range of values such as 0.025 0.05 0.10 or 0.025 to 0.05 by 0.005.

Sample Size
t1 (Exposure Time of Group 1)
Enter a value (or range of values) for the fixed exposure (observation) time for group 1. Each subject in group 1 is
observed for this amount of time. If the exposure times are variable, this is the average exposure time per subject
in group 1. The value must be greater than 0.
A single value may be entered here or a range of values such as 0.8 to 1.0 by 0.05 may be entered.
t2 (Exposure Time of Group 2)
Enter a value (or range of values) for the fixed exposure (observation) time for group 2. Each subject in group 2 is
observed for this amount of time. If the exposure times are variable, this is the average exposure time per subject
in group 2. The value must be greater than 0.
A single value may be entered here or a range of values such as 0.8 to 1.0 by 0.05 may be entered.
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Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N1, solve for N2
Select this option when you wish to fix N1 at some value (or values), and then solve only for N2. Please note
that for some values of N1, there may not be a value of N2 that is large enough to obtain the desired power.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1, solve for N2”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
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For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
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N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.

Effect Size
λ1 (Event Rate of Group 1)
Enter a value (or range of values) for the mean event rate per time unit in group 1 (control).
Example of Estimating λ1
If 200 patients were exposed for 1 year (i.e. t1 = 1 year) and 40 experienced the event of interest, then the mean
event rate would be
λ1 = 40/(200*1) = 0.2 per patient-year
If 200 patients were exposed for 2 years (i.e. t1 = 2 years) and 40 experienced the event of interest, then the mean
event rate would be
λ1 = 40/(200*2) = 0.1 per patient-year
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Event Rate Ratio
λ1 is used with λ2a to calculate the event rate ratio as
RRa = λ2a/λ1
such that
λ1 = λ2a/RRa
The range of acceptable values is λ1 > 0. You can enter a single value such as 1 or a series of values such as 1 to 2
by 0.5.
RR0 (Ratio of Event Rates under H0)
Enter a value (or range of values) for the ratio of the two mean event rates assumed by the null hypothesis, H0.
Usually, RR0 = 1.0 which implies that the two rates are equal (i.e. λ1 = λ2). However, you may test other values
of RR0 as well.
•

One-Sided
The upper and lower null and alternative hypotheses are
Upper: H 0 : RR ≤ RR0 versus H a : RR > RR0
Lower: H 0 : RR ≥ RR0 versus H a : RR < RR0

•

Two-Sided
The null and alternative hypotheses are

H 0 : RR = RR0 versus H a : RR ≠ RR0
Enter λ2 or Ratio for Group 2
Indicate whether to enter the group 2 event rate (λ2a) or the event rate ratio (RRa) to specify the effect size.
The event rate ratio is calculated from λ2a and λ1 as
RRa = λ2a/λ1
RRa (Ratio of Event Rates under Ha)
This option is displayed only if Enter λ2 or Ratio for Group 2 = “RRa (Ratio of Event Rates under Ha).”
This is the value of the ratio of the two event rates, λ1 and λ2a, at which the power is to be calculated.
The event rate ratio is calculated from λ1 and λ2a as
RRa = λ2a/λ1
The range of acceptable values is RRa > 0 and RRa ≠ RR0.
You can enter a single value such as 1.15 or a series of values such as 1.05 to 1.20 by 0.05.
RRa (Ratio of Event Rates under Ha) [when solving for RRa (Ratio of Event Rates)]
Specify whether to solve for event rate ratios that are less than one or greater than RR0.
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λ2a (Event Rate of Group 2 under Ha)
This option is displayed only if Enter λ2 or Ratio for Group 2 = “λ2a (Event Rate of Group 2 under Ha).”
Enter a value (or range of values) for the mean event rate per time unit in group 2 (treatment) under Ha, the
alternative hypothesis.
Example of Estimating λ2a
If 200 patients were exposed for 1 year (i.e. t2 = 1 year) and 40 experienced the event of interest, then the mean
event rate would be
λ2a = 40/(200*1) = 0.2 per patient-year
If 200 patients were exposed for 2 years (i.e. t2 = 2 years) and 40 experienced the event of interest, then the mean
event rate would be
λ2a = 40/(200*2) = 0.1 per patient-year
Event Rate Ratio
λ2a is used with λ1 to calculate the event rate ratio as
RRa = λ2a/λ1
such that
λ2a = RRa*λ1
The range of acceptable values is λ2a > 0. You can enter a single value such as 1 or a series of values such as 1 to
2 by 0.5.
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Example 1 – Finding the Sample Size
We will use the example of Gu (2008) in which epidemiologist wish to examine the relationship of postmenopausal hormone use and coronary heart disease (CHD). The incidence rate for those not using the hormone
is 0.0005 ( λ1 = 0.0005). How large of a sample is needed to detect a change in the incidence ratio from RR0 = 1 to

RRa = 2, 3, 4, 5, or 6. Assume that 90% power is required and α = 0.05. Assume that each subject will be
observed for two years and that the design calls for an equal number of subjects in both groups.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for the Ratio of Two Poisson Rates procedure window. You may then make the
appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example
Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ One-Sided
Test Statistic ........................................... W5 = Variance Stabilized
Power ...................................................... 0.90
Alpha ....................................................... 0.05
t1 (Exposure Time of Group 1) ............... 2
t2 (Exposure Time of Group 2) ............... 2
Group Allocation ..................................... Equal (N1 = N2)
λ1 (Group 1 Event Rate) ......................... 0.0005
RR0 (Ratio of Event Rates under H0) .... 1
Enter λ2 or Ratio for Group 2 ................. RRa (Ratio of Event Rates under H0)
RRa (Ratio of Event Rates under Ha) .... 2 3 4 5 6
Reports Tab
Decimals for Event Rates ....................... 4
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Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Testing the Ratio of Two Poisson Rates
Alternative Hypothesis: One-Sided (H0: RR ≤ RR0 vs. Ha: RR > RR0)
Test Statistic: W5 = Variance Stabilized

Power
0.90001
0.90000
0.90001
0.90002
0.90001

N1
29737
10777
6364
4513
3514

N2
29737
10777
6364
4513
3514

N
59474
21554
12728
9026
7028

Grp 1
Expos
Time
t1
2.0
2.0
2.0
2.0
2.0

Grp 2
Expos
Time
t2
2.0
2.0
2.0
2.0
2.0

Grp 1
Event
Rate
λ1
0.0005
0.0005
0.0005
0.0005
0.0005

Grp 2
Event
Rate
λ2a
0.0010
0.0015
0.0020
0.0025
0.0030

Alt
Rate
Ratio
RRa
2.000
3.000
4.000
5.000
6.000

Null
Rate
Ratio
RR0
1.000
1.000
1.000
1.000
1.000

Alpha
0.050
0.050
0.050
0.050
0.050

References
Gu, K., Ng, H.K.T., Tang, M.L., and Schucany, W. 2008. 'Testing the Ratio of Two Poisson Rates.' Biometrical
Journal, 50, 2, 283-298.
Huffman, Michael. 1984. 'An Improved Approximate Two-Sample Poisson Test.' Applied Statistics, 33, 2, 224-226.
Report Definitions
Power is the probability of rejecting the null hypothesis when it is false. It should be close to one.
N1 and N2 are the number of subjects in groups 1 and 2, respectively.
N is the total sample size. N = N1 + N2.
t1 and t2 are the exposure (observation) times in groups 1 and 2, respectively.
λ1 is the mean event rate per time unit in group 1 (control). This is often the baseline event rate.
λ2a is the mean event rate per time unit in group 2 (treatment) under the alternative hypothesis.
RRa is the ratio of the two event rates under the alternative hypothesis. RRa = λ2a/λ1.
RR0 is the ratio of the two event rates under the null hypothesis.
Alpha is the probability of rejecting the null hypothesis when it is true. It should be small.
Summary Statements
For a one-sided test of the null hypothesis H0: RR ≤ 1.000 vs. the alternative Ha: RR > 1.000
using the W5 = Variance Stabilized test statistic, samples of 29737 subjects in group 1 with
exposure time of 2.0 and 29737 subjects in group 2 with exposure time of 2.0 achieve 90.001%
power to detect an event rate ratio (RRa) of 2.000 when the event rate in group 1 (λ1) is
0.0005 and the significance level (alpha) is 0.050.

This report shows the values of each of the parameters, one scenario per row. The values of power and beta were
calculated from the other parameters.
Power
Power is the probability of rejecting the null hypothesis when it is false. It should be close to one.
N1 and N2
N1 and N2 are the number of subjects in groups 1 and 2, respectively. To calculate the sample size in terms of
person-time, you would multiply the sample size by the exposure time, ti. For example, the group sample size in
the first row calculated in person-years is 29737 x 2.0 = 59474 person-years.
N
N is the total sample size. N = N1 + N2.
t1 and t2
t1 and t2 are the exposure (observation) times in groups 1 and 2, respectively.
λ1
λ1 is the mean event rate per time unit in group 1 (control). This is often the baseline event rate.
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λ2a
λ2a is the mean event rate per time unit in group 2 (treatment) under the alternative hypothesis.
RRa
RRa is the ratio of the two event rates under the alternative hypothesis. RRa = λ2a/λ1.
RR0
RR0 is the ratio of the two event rates under the null hypothesis.
Alpha
Alpha is the probability of rejecting the null hypothesis when it is true. It should be small.

Plots Section

This plot shows the relationship between group sample size and RRa.
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Example 2 – Validation using Gu (2008)
Gu et al. (2008) present an example that we will use to validate this procedure. Using the scenario cited in
Example 1 above, they give a sample size calculation on page 295. In this example, λ1 = 0.0005, ρ 0 = 1, ρ a = 4,

t1 = t2 = 2, α = 0.05, R = 0.5, and power = 0.9. In their Table 6, they list the sample size for p5( A) in this scenario
as 8627. However, this number is inaccurate because of the two-decimal place rounding that was done during
their calculation. In a private communication, they agreed that the more accurate number is 8590.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for the Ratio of Two Poisson Rates procedure window. You may then make the
appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example
Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ One-Sided
Test Statistic ........................................... W5 = Variance Stabilized
Power ...................................................... 0.90
Alpha ....................................................... 0.05
t1 (Exposure Time of Group 1) ............... 2
t2 (Exposure Time of Group 2) ............... 2
Group Allocation ..................................... Enter R = N2/N1, solve for N1 and N2
R ............................................................. 0.5
λ1 (Group 1 Event Rate) ......................... 0.0005
RR0 (Ratio of Event Rates under H0) .... 1
Enter λ2 or Ratio for Group 2 ................. RRa (Ratio of Event Rates under H0)
RRa (Ratio of Event Rates under Ha) .... 4
Reports Tab
Decimals for Event Rates ....................... 4

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Testing the Ratio of Two Poisson Rates
Alternative Hypothesis: One-Sided (H0: RR ≤ RR0 vs. Ha: RR > RR0)
Test Statistic: W5 = Variance Stabilized

Power
0.90001

N1
8590

N2
4295

N
12885

R
0.50

Grp 1
Expos
Time
t1
2.0

Grp 2
Expos
Time
t2
2.0

Grp 1
Event
Rate
λ1
0.0005

Grp 2
Event
Rate
λ2a
0.0020

Alt
Rate
Ratio
RRa
4.000

Null
Rate
Ratio
RR0
1.000

Alpha
0.050

These results match the more accurate value of 8590.
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